


STEP 4

HWASIX K
SZE Rk

STEP 1 STEP 2

&Rz 2 1ILibrary




SHEH

MREHERE

-[EABER . F%REM

- Fliter (@828 ) 2TE?

- THEEFER : B¥4H - =& -~ #= - Find Full Text ~ #tZR ZHEUY + EndNote Click
- [@FSync ~ 9 =Share

SBBRER

- CWYW#EPE 4R 5
- 2ENRMIERELYR - Z1F5E
------ BELERNUS
- EERARERERN - TEHMEH - PEXED




Eﬁ%"ﬁ-




N 00
|Fe|
=

\Y
1Y

| BHEE | gnezss | =massm | Bsev
¥ HHAE (BMEOLIR : 30F)

@HELH(0)E
OFE* #(0)E
BN (RERUBEE AR
OBZER

EEFERHLES

OAPA Style

OChicago (Turabian) Style
OMLA Style

(OCNS-13611 Style

(OCSE Style

:

E
|
UI

E

@RIS format(EndNote - RefWorks...

)

) 2

E

@UTF-8

OBIGS
OGB2312

F§ET Bs | mERas

s

=g

=A\

24|

o O 1E 2 475 (B 1S A)

.. Summary Edit PDF X

Imported References [T x +
Advanced search

{Tsé:t,e‘?‘References BAR®

Author Year Title Rating Joumnal  Last Updated Reference Type

SR, 2021 PR BERIERRT.. ERBER 2022/513 Thesis

&T 2019 LA ST 23 4 Bl SR R R EE.  2022/5113 Thesis

[ i 2022 Ll RsEEREILHESR. BESR. 2022/513 Thesis

BRETIE, 2021 MEFORRRENE_F. RIET. 2022/5/13 Thesis

SR, 2020 BEERTREFLER REE.  2022/513 Thesis

2EE, 2021 GEPEE AR T WWE. 2022/513 Thesis

FEH, 2022 BETMTRZEEER—. M. 2022/5/13 Thesis

BEA, 2021 REERTRERBESZ. BB, 2022/513 Thesis

HiEd 2020 RFREERRERR 2 EhEE.  2022/5M13 Thesis

s, 2020 EmARERNFIEEE. #AT. 2022/5013 Thesis

Bk#, 2020 ERTRNHTRETE S @R,  2022/513 Thesis

58 2020 FRTRANEFHEREN. FEE 2022/5/13 Thesis

A, 2021 ZRTRERBERENE.. BERER 2022/513 Thesis

+ Attach file

Mﬁlﬁﬁ?ﬁfﬁﬁﬁiﬁﬁﬁiwfﬁﬂ
RS B AT AR R T

{53

F

1]

UEEAR B 2019

FTLELH LA EEEEEE
L& (Volatile Organic
Compounds, VOCs) I
HMEP - BEAFE
IERSR . FRLET

2]

BIE5
AREEHBEEEIEE  IF
MARMEHRER
AR AR
TEZHEMTLEE - ORERS
Hitvocs2TH - IRBIR_

APA Tth -] | Ceom |~



E ARG EEITIRIRSI 24

Q : BBARE R T &2 .txttE - Import Option # “EndNote Import” Z A AR INE A ?

A FEINEEEZHTRXRSIRFliter (BEss ) - 7 JEREAZR -

@ BREE
L BAFY X RX §"11§ﬁ
=N

NCL Taiwan Periodical Literatu

|
BERTATE

HHE > BETATH

BETATH

I Adobe Reader PDF2IE %R

EndnoteZEEERE
BERTE
fEHEA

(BiLERRH
| svisceneEmEmng



i

4 > mEseE v B
L]
+ BEEE m File Edit Tools Window Help
W EE Aot e Tools Window Help
» Author Parsing Full Name: N
‘ = ' Continuation Lines Based on: EH W
EET '::i‘"eg‘”yge Infomasenprovcer: @5 Open Library... Ctrl+0
= tor Parsn
MCL Journal Field Editing Crested * Open Shared Library... Ctrtl+Shift+0
= H TPL en{ MARC Records Last modified: 202
- ':m"* P“YD“‘ Comments and initations: Open Recent »
curce Parsing Comments and iatiors: |
ive - ERTE TEREE N NoteVFiltersE3§ T » FIEFEEA -
& OneDrive - Personal ) Close Filter Ctrl+W
) BT ¢
O =g aue L
168 T
J 30 1t 2¥5§File—>lmpcq Save As... -8 A EEEHEA -
R — EEEEE Ty 0" 2 CORY-
https//tpl.ncl.eduty Revert Filter...
Print... Ctrl+P
Print Setup...
Exit Ctrl+Q
Save As ?

Filter name: e T P

Save

\

S

SRBEE Cance




Title Rating Journal Last Updated Reference Type
3D BN/ NR BRI BRI . EE8B8  2022/4/13 Journal Article
|E o] =l Import File ? x
3D FINEHR K RIEE
o Import File: |export(1).b(t ST E :/7 1% ﬁﬁ | m rt > F‘ | ’ | m rt O t‘ n
10 SINEE A BN ‘ R po ile port Optio
— : S TR E) 1350 B B 7 2
3D print additi h N PDF ;EI\ } m' iﬁl ay iEl \Flter
P”nt a itive tec Duplicates: EndNote Library
EndMote Import
. Text Translation: Refer BbIX
3D print of polymer b Tab Delimited I
Reference Manager (RIS)
ISI-CE
‘ Multi-Filter (Special)
3D print of polymer bonueu= kel
Other Filters...
3D print so more scholars ca Imported References  x [Nt x +
3D printing and its impact o... G Advanced search
®|mported Refer... 5
Imported References gl
3N nrintina in medicine Whnaodhe 5 References
Author Year Title Rating Journal  Last Updated Reference Type
v MY GROUPS B 1955 BEETRASHEESND. hEL. 2022/5/13 Journal Article
e 016 BHEMTRNRPRIR. mEa. 2022513 Journal Article
v FIND FULL TEXT
AT sk, .. 2018 BRANSEHREENAT. =®0.  2022/5/13 Journal Article
 ONLINE SEARCH 2019 BT RERERE.. WS 2022/5/13 Journal Article
| Inform ... 2013 HEILBERE(LMER.. BEESRIE 2022/5/13 Joumnal Article

ZHOAINEA |

ibran

Libra

No reference selected

x



FrAE M EEEndNote#l A ¥4 fEFliter

Import File

Import File:

Import Cption:

Duplicates:

Text Translation:

Choose...

=R RIS (iR

FOF

EndMote Library

EndMote Import

Refer /BibIx

Tab Delimited

Reference Manager (RIS)
ISI-CE

Multi-Filter [Speaal}

E HHATE 32?% [
Use Connection File...

Choose An Import Filter x
Name Information Provider 2
WaorldCat Diss {OCLC) QCLC
Wos Alert (Clarivate) Clarivate Analytics
WPIDS (STM) STN
WPINDEX {STN) STN
WPIX (STH) STN
Yale U Library Catalogs
Zentralblatt MATH European Mathematical Society
zetoc (MIMAS) MIMAS
Zoological Record (DL)

Zoological Record {OvidsFP) ET ?;Z
Zotero RIS X
]
|Quick Search v| Find by »

4 | ess Info: Cancel

File Name: ZEEAHERCSIES (30 enf
Created: 20229F5H13H, 74 08:28:24
Modified: 20222E58138, T4 08:28:24

Based On: BiY

Category: EFBEEEE

Comments: | =4 T & CEIRE ST B S Filter ~
(EENCL _Journal TPL enf) » dEREFFREndNote

Clhmwing 493 af 493 imeort filters




IR B A Bl R

File Edit References Groups Library Qs[slll Window Help

Install EndNote Click Browser Extension

Quiout Stvles

nc Configuration

Import Filters

New Filter...

B All References
®|mported Refer... 5
ARecently Added 40

Connection Files

Cite While You Write [CWYW]

Format Paper
Subject Bibliography...

Show Cannectinn Status

1 cmsmmnsvzace.

Y Fl

er EEEHE ?

Open Filter Manager...

No reference selected

X

Advanced search

Filters
File Edit QslIE® Window Help
Name Information Provider @
[ urban Studies Abs (EBSCO) EBSCO
[m]us Epa =
[ vetus Latina BREPOLS
[] wanfang Data Wanfang Data
[ wastelnfo (DL) DIALOG
[ Water Resources (EBSCO) EB5CO
[] web of Science Core Coliection (Clarivate) Clarivate Analytics
[ weldasearch {DL) DIALOG
- qistry Platform
BHE T Getm the Web
A A e ore on the VVvebp 4
[ wilson Art Index (OvidSP) Zoash
[ wilson Human Abs {OvidSP) OvidsP
[ wilson Index Legal (OvidsP) e ¥
Get More on the Web... Mark All Unmark All Find by *

4 Less Info:

File Name: US EPA.enf

Based On:
Category: USEPA

Created: 2022F4H 130, T-F 01:15:43
Modified: 20175 4H 148, FF 12:08:48
v.epa.gov/natibraols.him

Comments:

Showing 493 of 493 import filters.

After displaying results, click "Bibliography” to display data in a tagged format. Copy and paste  *
that data into a plain text file, which can then be imported using this filter. Records should look — «

BRAE@®

™
EndNote Product Details Training Support

699 filters found
. lll
Information Provider Database

Get Started

70 nexts

PubMed NLM-Pubmed
EndNote Import Generic

BibTex (Sample) Clarivate

RefMan RIS Clarivate

ISI-CE Clarivate Analytics
zetoc MIMAS

APA Psyclnfo (Ovid) Ovidsp
EMBASE.com Elsevier

Web of Science Alert (Clarivate e

TOC Alert (Clarivate) arivate

ZEndNoteEA Ml ( EZLAXRE )

Date

2022-03-30

2022-01-27

2021-07-19

2021-05-13

2020-11-14

2020-07-01

2020-04-08

2019-11-12

2019-08-23

2019-08-23

Contact Sales: +1-288-418-1937

wnload

wload

wnload

wnload

wnload

whnload

wnload

wnload

wnload

whnload



#1318 Fliter BRIFEFR T

[EssE B ERE RN
o 12 B I 388 T Al

BEEHEMEL

« 23X >File>Save as...>FEIEZ

ESIESEE RPN

« KH#>>EndNote>Filters ( 377 )
« AK#%>(C:)>Program Files>EndNote 20 > Filters ( 78z%



ThBE X FEH

AFAH
=5

L=

Find Full Text
X BV
EndNote Click




1.554 -8

=HE&ER

Create Group
Create Smart Group...

Create From Groups...

Rename Group
Edit Group..
Delete Group

Share Group..

Add References To
Remove References From Group

Create Group Set

Delete Group Set

Rename Group Set

Create Citation Report
Manuscript Matcher

EilERE

=
ZIH
(TTTTHN

B PEE

Create Group (—#%##4H) S

g ]’/\+

B Create Group Set —

EHP PN

Create Smart Group...(EZ%i4) s
REEREEFSHNEEERBEMARH

B Create From Groups...(55%#/H)
BHAHRBIES (AND ~ OR ~ NOT)




Create Group * Create Group Set

Bl - 2 17— ARRYAF 4

Lib

Library Tools Window Help

My Groups

©Sync Configuration ‘

BAll References 113
LRecently Added 0

BUnfiled gl My Groups
0 References

"y ot il = BV i) e |

File Edit Referel (X\[]lz K %; % % E I%\ %Q)

WTrash

Sync Configuration

Jthor Year N

All References 113
fQRecently Added 0 .
B Unfiled 2 oliiag

0 References

v Group 5S¢

vFIND FULL

v GROUPS s

"
WTrash Advanced search

v MY GROUPS Author Year Title

e B OB

~ MY GROUPS Author  Year Title Rating Journal  Last Updated Reference Type

Create From Groups.

FiRi, 2020 ARSARANIFEER. ®7I.  2022/5/13 Thesis

Create Group Set
2016 DTN A ERTRE. HEA 2022/4/13 Journal Article

Rename Group Set

Delete Group Set

2021 i

SRTRNRREEE. BB, 2022/5/13 Thesis
Openin New Tab
FIND FULL TEXT S, 2020 EaFRs R EREn. B 20227513 Thesis

EROURE SHARE I¥E 2019 DREMEEHERES 2 MAATI 2022/4/13 Journal Article

NLINE SEARCH
S8, 2020 ZRATRAHERNEEUR. ERE 2022/5/13 Thesis

REEE .. 2019 Z B @30T DT FHE.. tERE.  2022/4/13 Journal Article




< Sync Configura...

BlAll Referen... 113

Create Smart Group

Bl ;- B —1fE 2Es RERE A ( ERankingf&EcfE R )

EndMote 20 - My EndNote Library0413.enl

File Edit References Groups Library Tools Window

My Groups

Help

Advanced search

QRecently Add... 0
B Unfiled 9%
0

My Groups

17 References

AR@®

Cieaie Groug

Author

Teate Tom Groups.

Create Group Set
Rename Group Set

Delete Group Set

Openin New Tab

v FIND FULL TEXT
v GROUPS SHA...

v ONLINE SEAR...

Create Smart Group...

FRE,

BHED,
FHE,

BIEYE; ..

Srart Group

i N\ BF 4 2 T KR ] BB

Smart Group Mame: |E,=

=R

| [+ [X]

| [ [x]

[EET—— | [ d| T
|.-5.n|:| V||‘fear V||Cnntains V||
|.-5.n|:| V| |'I'|ﬂe V| |C-:untains V| |

JERIEY

Cancel




m]

My EndNote Library0413.enl -

File Edit References Groups Library Tools Window Help

B +
©Sync Configura... | | | & No reference selected
E All Referen... 113 Advanced search
QRecently Add... 0 .
& Unfiled o | A Q) &

WTrash 0

v MY GROUPS %éﬁ@iﬁﬂ%@];&}\%ﬁﬁqﬂ Rating Journal :

v SURKE Y | caldivar, ... 2017 Influence of processing and ... Additive...
o Tan, Q; Z.. 2020 A novel method to 3D-print ... Additive...
RRE
v E Smith, D... 2018 Pharmaceutical 3D printing: ... Internati...
®20174... 33 Premysl, .. 2018 Effect of Selected Commerci... Materials
@®20174...
Nindel, T.. 2021 A gradient-based framework... ACM Tra...
il E
B cnki Nilsson, .. 2021 Step-by-step guide to 3D pr... Applied ...
BGoogle ... McCorm.. 2021 Growing and Evolving 3D Pri... IEEE tran...
Markl, D.,... 2017 Analysis of 3D Prints by X-ra... Pharmac...
VFIND FULL TEXT
Marappa,... 2018 EGCG assisted Y203:Eu3+ na... Sensors ...
v GROUPS SHA...
| A A N1 Intarmratimea ctaradslifheacmarams b Rarmi~A Dr w i




Create From Groups

Bl - REEREFAPEE 2020-2022 F B E R B 48

My EndNote Library0413.enl
File Edit Groups Library Tools Window Help Create From GrDUPS

IUse these options to create a new Group based on the criteria below:

ync Configura...

B All Referen... 113 Advanced search
QRecently Add... 0

. 2022 o
B Unfiled 96
e AL@ Indude References in:

S References

Group Name: |Abnuﬂ2020-2l]22

W Trash 0
v MY GROUPS Author Year Title Rating Journal I |2|:|2D bl | +
Julian Lo.. 2022 Clinical acceptance of advan... 3D printi.. 4 or " |2|:|21 — | +
HTE, 2022 BHRNERERRE | TR.. BEME.
" . . . o v/ |02 v] [+
BAIE, 2022 BREERESILHES.. BER. 2
Create Group
e —— WAE, 2022 EET T EHEREER. PDHEE. 3 And ™| |Selecta Group V| +
et FH, 2022 BERGTRCEEESR—. HEH. 4
I And v | |Selecta Group v| +
elete Group Set
Open in New Tab




My EndNote Library0413.enl

File Edit References Groups Library Tools Window Help

=~ Sync Configuration

E All References
ARecently Added
B Unfiled

WTrash

v MY GROUPS

®2020L4 A1

®2021

@2022
®About2020-2022

36

About2020-2022 +
| | | & No reference selected  x
Advanced search
About2020-2022 A
A @
36 References
Author Year Title Rating Jou
Tan, Q;Z.. 2020 A novel method to 3D-print ... Ad
Nindel, T.. 2021 A gradient-based framework... AC
Nilsson, .. 2021 Step-by-step guide to 3D pr... Ap
s e =52\ AY AV ‘ H - .
FERNER BE)E AREZH rowing and Evolving 3D Pri... IEE
R 7 = <linical acceptance of advan... 3D
Berman,.. 2021 HowDIY: towards meta-desi... 26t
15, 2022 MM ERREE : 8. 1
AT, 2020 FEERTHERETR.. n3
BT 2020 Be# =58 Fr93DITEIF.. 1
B i 72 e Taw Tl L 2 D = T BhafEE g ES B |




My EndNote Library0O413.enl

File Edit References Groups EELIelyY

Sync Configuration

Tools Window Help

Sync

Advanced Search Cirl+Alt+F

Sort Library...

Find Duplicates

B All References

ARecently Added
B Unfiled

W Trash

v MY GROUPS

P =
[N =

v R

@2020

Find Broken Attachment Links
Remove Broken Attachment Links...

Open Term Lists 4

Define Term Lists... Ctrl+4

Link Term Lists... Ctrl+3

Spell Check Ctrl+Y hr

Find and Replace.. Ctrl+R

Change/Move/Copy Fields... 14

Recover Library...

Library Summary 16
Stopp, Se.. 2008
Cannm -+ 2N1A

lmli
[

Tl
(ILL]Y
=2

EN Find Duplicates

Comparing 1and 2 of 2 duplicates.

o EEEGFAIE
ExEr-RAZBR

AmiE - B

Skip Canicel

Select the record to keep. The record not selected will be moved to the Trash, Select Skip to go to the next set of duplicates,

Keep This Record

FTURRE, 2013 #121

Keep This Record

FTERE, 2013 #126

Reference Type Journal Article
Author ZFRE,
EES,
HEE,
RER,
Year 2013

Added to Library: 2022513  Last Updated: 2022/5/13

#EiZCancelBlEEEMA
WY 2R EREES
=302
REE,
EER,

Year 2013

il

Last Updated: 2022/5/13

= NEL 8 erT an T

Added to Library: 2022513




File Edit

Sync Configuration

B All References

y Tools Window Help

Duplicate References

Advanced search

2 Duplicate Refe...
A Imported Refe... 2
Recently Added 9

Duplicate References

12 References

AR @

S Unfiled

W Trash

¥ MY GROUPS

v My Groups

L, CIRIN CIILL TCVT

Author Year Title Rating Reference Tyf
He, Guanming; L.. 2022 Does air pollution impair investment efficiency? Journal Articl
He, Guanming; L.. 2022 Does air pollution impair investment efficiency? koo Journal Articl
Liy, Ly; Fang, Jia.. 2022 The effect of air pollution on consumer decision making: A review Journal Articl
Liy, Ly; Fang, Jia.. 2022 The effect of air pollution on consumer decision making: A review Koo Journal Articl
Pandey, Anamik.. 2021 Health and economic impact of air pollution in the states of India: the Global Burden of Disease Study 2019 Journal Articl
Pandey, Anamik.. 2021 Health and economic impact of air pollution in the states of India: the Global Burden of Disease Study 2019 == - - - Journal Articl
Wang, Zhaohua;.. 2022 Environmentally vulnerable or sensitive groups exhibiting varying concerns towards air pollution can drive governm... Journal Articl
Wang, Zhaohua;.. 2022 Environmentally vulnerable or sensitive groups exhibiting varying concerns towards air pollution can drive governm... * = = - - Journal Articl
Xue, Yueguang; .. 2022 Air pollution: A culprit of lung cancer Journal Articl
Xue, Y,; Wang, L;.. 2022 Air pollution: A culprit of lung cancer Koo Journal Articl
Yu, Shuangli; Sh.. 2022 Air pollution and executive incentive: Evidence from pay-performance sensitivity Journal Articl
Yu, Shuangli; Sh.. 2022 Air pollution and executive incentive: Evidence from pay-performance sensitivif

BEE%E MEERDelete
sE—1x o] DA E MR |




3EBW  RERIFRE

BEES ESFRARU
e

Advanced search

Al eferences

Author ¥||Contains v + || x
And ~||Year ~||Contains v + || x
And v || Title ~||Contains ~ + || %

AP - BREEAIMEE Simple search Search options ~



4.Find Full Text : E X EBAHAEE X

RABZ—R FEHAREEN

My EncdNote Library0413.enl
File Edi1Gr’Dup5 Library Tools Window Help

Nve Reference Ctrl+N PDF
Edit Reference Cirl+E
Copy References To 4 =l x
Copy Formatted Reference Ctrl+K ‘Author V‘ ‘Contains M ‘ lz‘ No reference selected
E-mail Reference
Move References to Trash Ctrl+D ‘Year V‘ ‘Contams - ‘ E‘
File Attachments v ‘Title V‘ ‘Contains v ‘ E
Find Full Text 4l
ng Reference Updates , Simple search Search options ~
Figure »
Web of Science i PDF FEEMNEEER A
Reference Summary rences
s00gle Scholar
nEEEEE... 4 Author Ye: . Title Rating Jou
Vv FIND FULL TEXT Konci¢, Ja.. 2018 3D print additive technolog... Ind
Found PDF
McCorm... 2021 Growing and Evolving 3D Pri... IEE
¢ Found URL 9 9
Not found 8 Song, C,;.. 2016 My smartphone knows what ... * Prc
v GROUPS SHARED BY ... Savage, V.. 2014 A Series of tubes: Adding int... * uls




S.HMRARERUAS

ARF—X/NE ~ EERZRE NI - AIIHERIIName of DBHELHTIE &k E

My EndNote Library0413.enl Change/Move/Copy Fields

File Edit References Groups QELIEW Tools Window Help Move/copy Flelds :

e Chang Filds | Move/Copy Fields o —EUASHRES —EI
i § Advanced Search Crl+Alt+F
B Unfiled Sort Library...
WTrash Find Duplicates — In: | Name of Database v Insert Special »
Find Broken Attachment Links
~ MY GROUPS Remove Broken Attachment Links... — Change
Open Term Lists 4 . Google Scholad
- ) (® Insert after field's text:
Define Term Lists... Ctri+4
Link Term Lists.. Ctri+3 (O Insert before field's text:
Spell Check Ctri+Y {1
Ar Title
Find and Replace... ctl+R | (O Replace whole field with:
Change/Move/Copy Fields... -Iq gg == O Clear field
Recover Library...
@20201&1% Library Summary 20 3"5 F) Change case
@ Sentence case.
#2021 “ I, 2019 3D3IIE
®2022 5
= =g
®About2020-2022 36 KHE, 2020 /T Include a space before the new text B I u P | Al A:L 5
EET, 2021 Ry Include a space after the new text
B cnki B ... 2016 3DFTH s s2mm
B Google Scholar




HERELHC

BRARAK—ANNE - EBERZEKGHR - AlAHIRIRName of DB AU ZHE

My EndNote Library0413.enl Find and Replace oy
File Edit References Groups JELIEE Tools Window Help

Sync
In: | Mame of Database “ Insert Special *
Advanced Search Ctrl+Alt+F

nc Configuration Sort Library... Find:
Find Duplicates I

E All References Find Broken Attachment Links

Q-Recently Added Remaove Broken Attachment Links...
Open Term Lists 4

B Unfiled
Define Term Lists.. Ctrl+4 [ |Match Case Match Words
WTrash Link Term Lists... Crl+3

criki

Replace with:
Spell Check Ctrl+Y L

Find and Replace... Ctrll+R 8 I:F[,H\H‘T:U %ﬁﬁi§§|

Change/Move/Copy Fields... 17

v MY GROUPS

Recover Library...

Library Summary 19 Retain Capitalization

W 2021 Cancel




EA

6.EndNote Click : & HEZH—=

]JII

EndNote ClickZ I SHEME XN EAEZR=INIET, « O = TE
BiEndNoteiE4E - I AdoilNE X ERIEE B E R —E AEndNote -

EndNo lote Library.enl

File Edit R ps Library IRl Window Help
Install EndMote Click Browser Extension

Output Styles

© Sync Configuration 3
M 9 Import Filters ’ v ‘ E
B All References Connection Files 4 .
: %]
& Im ported Referen... Cite While You Write [CWYW] 4 ‘
Format Paper 4 M ‘ |Z|

A Recently Added
B Unfiled

W Trash

Subject Bibliography...

Show Connection Status Simple search Search options ~

Online Search...




EndNote Click

Formerly Kopernio

HRRIEE
N «  Enable downloads to EndNote$] 4
_%LZEHR PDFESZ 3 AMore settings>CustomiseZ %X
e e i 3 e e REEEIVEEEndNote

T
o
(2

»

BE > ®#xHE > EndNote Click - Formerly Kopernio

S
EndNote Clic,———*"

o

) clickendnote.com @ EEER (= I ) Enable downloads to EndMNote
Yk h ik 32 O | BEIE | 1.0000f - Enable the corner View PDF button

Enable the Inline View PDF buttons in the search results

HEVFETE  Feedback FAQs

T
frlk

2 Clarivate

More settings ...

EndN}Cl't?-‘ Click Q. Search Google Scholar




3. ScienceDirect Journals & Books

B View PDF Download full issue

Outline

The Lancet Planetary Health
Summary Volume 5, Issue 1, January 2021, Pages e25-e38
Introduction
Metheds
e Articles o o ) .
Oiscussion Health and economic impact of air pollution in
Osta sharing the states of India: the Global Burden of Disease
Supplementary Material © BAEHEE 4 =

References

Show full outline

Articles

Cited By (75)

Figures (4) ;
Health and economic impact of air pollution in the states of " ®
- . . P . . - = . —

HEIEX

I
File Edit Refere / Window Help

Imported References

Sync Configuration

‘Author VHComains v

B All References

Tables (2) ‘Year vHCUmains v

3 PDF B Tablel
HH Table2

Imported Referen... 1

)

‘Tme vHComains v

(L]
A Recently Added
E]

Unfiled . .
. Simple search Search options ~

W Trash
MY GROUPS

Imported References

1 Reference

v My Groups
FIND FULL TEXT
GROUPS SHARE... Author Year Title Rating Journal Last Updated Reference Type

ONLINE SEARCH + | @ & pandey,.. 2021 Health and economic impact.. * -« - - The Lanc.. 2022/5/27 Journal Article
Pand ey-2021 -Hij @ ABI Inform Glob.

® Jisc Library Hub ...

@ Library of Congr...

® PubMed (NLM)

@ Web of Science ...







B R 3 ETN8EE

FafEndNotefE AEIRIE ( RE )

EE

EEiFE[ELibrary - 2 HE R LB ZEndNote Library

ANy —)

o /1=

BUEME - TRBHRESZEEEER  WoEESZEL
B/ & Rl % 420 2 22 {ElLibrary - JNO] A ER ¥ 75 2 FRHERR




En 20 ary0413.enl

File Edit Refi Tools Window Help

Sync

Advanced Search Ctrl+Alf=F

Sync Co

E All Refer
A Recently
B Unfiled
WTrash

Sync Status

Sync Status

Sync Status

bynchronize your data with your endnot
Sync Status

Synchronize your data with your endnote acc Sync Status +

Sync Status

— @ Library’R &2

—{E &% B4
AN

Sync Details

Last sync Tuesday, May 17, 2022 at 09:30:58 AM +0800
Sync status: All changes have been sent.

Error code: None

EndNote

Using,

e Error message: None

Local Library

Library name: My EndNote Library0413.enl
encr [N References: 113

: Groups: 10

Group sets: 4

= d Attachments: 16

Online Library

Account email: dianelin1222@gmail com
Serial number: 3092075287

References: 113

BUEZE AGAREE — pel,
Edit > Preferences > 2% EndNote limite

Number of references: 1000000 (399887 can still be added)
Number of groups: 5000 (4990 can still be added)
Number of group sets: 5000 (4996 can still be added)

Defaults - BIE] k1B Z R E

Attachment storage: Unlimited

EndNote[EZ7AYE

= 4

ny

=

=

=~

N
D

N
N\



EndNote OnlineE & RTHIE R

File e ups Library Tools Window [[REnY

dianelin1222@gmail.com

2Sync Status

B All References
A Recently Added
B Unfiled

WTrash
v MY GROUPS

v My Groups

®2021
@2022
®About2020-2022

BGoogle Scholar 5
mEEEET.. 4

Vv FIND FULL TEXT

v GROUPS SHARED BY ...

Sync I:Ig EndNote online J
GWnload EnaNote Prug-ins

Get Technical Support

Sync Statu
Y EndNote Output Styles
Check for Updates.
Sync Sta  enanote community Refresh Stats £ -

Search Knowledge Base
EndNote Training Portal

Last sync: :58 1800
Sync statu Activate EndNote
Error code  About EndNote 20

Error message: None
©clarivie | EndNote

Local Library Ety
Library name: My EndNote Library0413.enl

ENSTITE 78 & L
References: 113
Groups: 10
Group sets: 4 BEER

Attachments: 16
Online Library

Account email: dianelin1222@gmail.com

Serial number: 3092075287 Bal, Jar 2018 ent of pilon fractures: a meta-analysis of randomized cantrolled triale
References: 113
Groups: 10 Berman, Alexander 202
Group sets: 4 "
Attachments: 16 (67.33 MB) 35 Boyer, Dustin 2018
Limits
Number of references: 1000000 (999887 can Chen, D 2013 adel for transiating specificatic 30 prints
Number of groups: 5000 (4990 can still be ac 17 May 2022
Number of group sets: 5000 (4996 can still b -
Attachment storage: Unlimited Coaklay, M. F. 2014 The e e st for Boscientiie and blemedicar 30 prnt

17 may 2022 17 May 2022

FE URL

e Ty D i e Al s sy o e nical practk

17 May 2022




I\ =
73 =

3
Al
ik
Ej

> ZLibrary

R My EndNote Library0413.enl
WTrash GOOQIE Scholar E 8"’ \); @ AW Cdit References Groups Library Tools Window Help
- 5 es New...
MY GROUPS e All References
) i Open Library... Ctrl+0
v My Groups Author Year Title Rating Journal Last Updated Open Shared Library.. Ctrtl«Shift+0
HEE, 2021 BHEETEETSSSEI. BB, 2022/5/16 Open Recent g
Close Ctrl+W
e -
it 2013 Z R NIRRT FEFR-3D FUED PEM.. 2022/5/16 Close Library
| B 2020 ERATENETREFEY. EHR. 2022/5/16 Save cri+s Al References
c G . N Save As... y
reate Group DTSR EERA AR 202275016 <ave a Coy [ 08 References
Create Smart Group
Create From Groups... 3BIRERERFRZEA EEEE 2022/5/16 I s l Author Year Title
Rename Group Export..
Delete Group Import » Koncic, Ja... 2018 3D print additive technolog...
HeeE Print... Ctrl+P N )
=k print Preview BEIO8R,; .. 2014 RS 3dPIENE B LAT..
Create Citation Report Print Setup
Manuscript Matcher ) McCorm... 2021 Growing and Evolving 3D Pri...
Compress Library (.enlx) ...
Create Group Set 3
Rename Group Set Exit Curl+Q Song, C;.. 2016 My smartphone knows what ...

Openin New Tab




EN Sharing x

Find People |
Sharing with ° Permission Status
dianelin@mail. thu.edu. tw Read & Write Pending -3
Remove
Remind
Read Only ° *5|3%/\_‘_¥j-%
~  Read & Write oo 3 s
- ENFTERBHRE
° ;im BE‘(/ \1/\ a2 %ﬁ;
Invite More People ® *A BE ¢ %EEII‘F $H
I add db ava == = ‘E ==
Enter email a resse/s;ejrie ¥ commas ?ﬁ HQ :Ié ﬁ':'% :ZE |:| HQ L 1=
[—
AR = 2 HE-mall
Permission: | Read & Write o a5 o
Add a mess Read & Write _ * BE . . N —
. Invitation to share an EndNote library = x & B
Read Only
° ,f% 'T/‘ noreply@endnote.com LF1003 @ AHE) Yo .
BHRHE v
$HIJ A Emall EF‘ 700N $H|J A n:l:l, /CA Lin Dai-An (dianelin1222@gmail.com) would like to share an EndNote library with you.
(—_I- K ) To accept this invitation and access Lin Dai-An's library, you must have EndNote X7.2 or later installed, and we strongly recommend using EndNote 20 for the best experience.

Once you've accepted this invitation, you will be able to access all of the references, PDFs, file attachments, and notes in this shared library from your EndNote desktop application.

&#26360;8#30446,&#36039;&#26009;8#20998;8#20139;

e e e a Pxee e ] S e A e Heprees b o400} Accept: https://account.endnote.com/enwservices/invitation/#/b1d98922-6a9f-45ae-beaf-48f55821d2¢7

Don't have EndNote for your desktop yet? Get the latest version now to access shared libraries and much more. http://endnote.com/buy?utm_source=en-
desktop&utm medium=edmé&utm campaign=Is-email-ro&utm_content=buy-en

If you do not wish to accept this invitation, please notify Lin Dai-An directly.



Lin has invited you to join a shared
EndNote library.

Leam More

To accept this invitation, sign in using the same credentials you use when accessing EndNote online or syncing your desktop
library, or create a new account. To access this shared library you must have EndNote X7.2 or later installed

Sign In with your EndNote account Create an EndNote account 8

Email First Name *

| | | |
=z 58 == ZX

Password ! 7&5( d‘é ™ =2 "

| | | |
et

Fa

your EndNote password? ‘ ‘

Password *

Confirm Password *

Invitation accepted. For access to Lin's
shared EndNote library, follow these =%

IO IL

instructions. O ) e

Purchase EndNote

PA3 vi I
Before you are able to access th = /\ bjz’ jJ 1 to purchase EndNote.

Buy EndNote Download 30-Day Trial

- <

Already have EndNote?
Windows 0s X

1 | .

L | | .

1. Click on the EndNote menu dropdown

2. Click on Check for Updates or download the installer

3. Click EndNote > Preferences > Sync

4. Enter EndNote account credentials. Be sure to enter the same
login information that you just used to sign in and accept this
invitation. Then hit Save

1. Click on Help = About

2. Click on Program Updates or download the installer

3. Click Edit > Preferences > Sync

4. Enter EndNote account credentials. Be sure to enter the same
login information that you just used to sign in and accept this
invitation. Then hit Save

You can now access the shared library from your desktop

Just go to File > Open Shared Library.
i~

Institutional Login

You can now access the shared library from your desktop
Just go to File > Open Shared Library.

? <

Support Share

EndNote now provides unlimited sharing between up to

Having issues accessing the shared library? Contact our Accessing EndNote through your institution? Check with



=B1BIRIER




CWYWiE P 4m g

EndMote 20 Edit & Manage Citations

Citation Count  Library

{Julian Louis et al., 2022; McCormack & Gambardella, 2021; Savage et al., 2014; Song et al., 2015; Stopp et al....

B B vccormack, 2021 47

My EndNote Library0413

Edit Reference | -

+ |4 song, 2016 #77 1 My Endhate Library0413 EditReference | -

4+ |4 savage, 2014 578 1 My Endhote Library0413 Edit Reference | -

4+ |4 Stopp, 2008 £54 1 My Endhate Library0413 EditReference | -

+ Julian Louis, 2022 #46 1 My Endhote Library0413 Edit Reference | ~
(Guoetal., 2017; BRMERE & BRSHE, 2015)

4| Guo, 2017 #30 1 My EndMate Library0413 Edit Reference | =

1+ 3555, 2015 #8 1 My Endhlote Library0413 Edit Reference | =

(Marappa et al., 2018; Marin da Fonte, 2018)

4 Marin da Fonte, 2018 #55 1 My EndMote Library0413 Edit Reference | ~

T Marappa, 2018 #86 1 My EndNote Library0413 EditReference | -

Default W

Display as: Author (Year)
Exclude Author
Exclude Year

Exclude Author & Year

Show Only in Bibliography

Edit Citation Reference

Formatting: | Default v

Prefix Default v

Suffix

Pages:

Display as: Author (Year)
Exclude Author

Exclude Year
Exclude Author & Year
Show Only in Bibliogra

Tools -

Cancel

Help

Edit Citation  Reference

Formatting: | Default ~

Prefix:
Suffix:

Pages:

DB BRI ;- BiAR G o
o Bl :

Prefix : s8R ;

Edit & Manage Citation(s)

Formatting :

a2 ECitation fE X P EI/RAIAE T
- TERE

- 1FE (F10)

° /\,zET,ﬂE%

* 7 \IZETE'{t
o FEREEMER

A#rCitation - EESEEP AN

B3R5 - B
#BRE B 58 ;12



ZR  BoUREE - FE - KIWVRAEHE

O

Q ESREEREtE

|,, 1  EN GotoEndMote Style: APA Tth - | g& Categorize References - Export to EndMote ~ e
I Qrt B Edit & Manage Citation(s)  [E! Update Citations and Bibliography [(2] Instant Formatting is On~ 100 Manuscript Matcher |
nse — elp
Citation ~ E;Ix. Edit Library Reference(s) E: Convert Citations and Bibliography - —= Preferences
Citations Bibliography T Tools
EndMote 20 Configure Bibliography *

Format Bibliography Layout

Font: Size:

i : SIRERET S E T RTEE -
KN R AR HEBEE

References Text Format...

Start with bibliography number:

First line indent: Line spacing: | Single -
Hanging indent: W Space after: MNane ~

ma =




SRk MRE AR

=rn. :—_I_

ALyE 82

EndMote 20

Style: APA Tth
E} Update Citations and Bib

EN Go to EndMote
B3 Edit & Manage Citation(s)

E‘b

Insert
Citation = E‘; Edit Library Reference(s)

liography

B2, Convert Citations and Bibliography -

g% Categorize References - Export to EndMote -

Group References by Customn Categories itcher

Configure Categories...

References.

Help

Citations Bibliography
EndMote 20 Configure Categories X
——
Author Year  Title Reference Type Category
o hcwgra..‘ = Guo 2017 3D printing PLGA: A quantitative... Journal Artice
Uncategunz;_ References  {3) JuianL... 2022  Clinical acceptance of advanced ...  Journal Artice
Categ.mrv Headings Marappa 2018 EGCG assisted Y203:Eu3+nano... Journal Article
- Prlmar; Sources © Marind... 2018 3D printso more scholars can ac...  Journal Article
Secandary Sources @ McCorm... 2021  Growing and Evolving 3D Prints Journal Artide
Savage 2014 A Series of tubes: Adding intera...  Conference Proceedings
Song 2016 My smartphone knows what you...  Conference Proceedings
Stopp 2008 A new method for printer calibra...  Journal Artice
w2015 PIFMEMESLZTEEER.. Jounal Artide
>
S\
LETBPTAR AR (2R3 Bl
\
+E’“ ) HHJB%K T2
B4 == A;E g J
composition
| and prnting parameters on PNt resoiuuon
Cancel Helo

journal«

Guo, T, Holzberg, T.R., Lim, C. G., Gao, F,, Gargava, A., Trachtenberg, J. E., Mikos, A.
G., & Fisher, J. P. (2017). 3D printing PLGA: A quantitative examination of the
effects of polymer composition and printing parameters on print resolution
[Article]. Biofabrication, 9(2), Article 024101. https://doi.org/10.1088/1758-

5090/aa6370 «
lulian Louis, M., Tobias, H., Florian Markus, T., & Philipp,

B. (2022). Clinical
acceptance of advanced visualization methods: a comparison study of 3D-
print, virtual reality glasses, and 3D-display. 3D printing in medicine, 8(1), 1-
10. https://doi.org/10.1186/541205-022-00133-7 «

Marappa, B., Rudresha, M. S., Basavaraj, R. B., Darshan, G. P, Prasad, B. D., Sharma,
S. C., Sivakumari, S., Amudha, P, & Nagabhushana, H. (2018). EGCG assisted

¥203:Eu3+ nanopowders with 3D micro-architecture assemblies useful for

latent finger print recognition and anti-counterfeiting applications [Article].
Sensors and Actuators, B: Chemical, 264, 426-439.
httne-//dai arg /10 101671 enb 2018 02 122 .




t

/_-I'

L

i
imo
[o

W
it

Install EndNote Click Browser Extension

Output Styles

dianelin1222@gmail.com Import Filters N Subject Fields x
Connection Files 4
ync Status
Cite While You Write [CWYW] 4 | I
All References Panad N |_Selected Fields: | _ =l
i J@ ubject e %
AR iy Added Show Connection Status LITRor
A Recen ddec
L d Online Search Year Selected Terms # Records Select Al
B Unfiled £ 0 Author Year Title Title
S Secondary Author Book Clear Selection(s)
WTrash - "
Kon¢i¢, Ja.. 2018 3Dpi SECC?SSLESEES Conference Proceedings
v MY GROUPS Publisher
BESER, .. 2014 FHI| | yolume
v My Groups
Mumber of Volumes
McCorm... 2021 Grow| | Number
Pages
Song, C,;.. 2016 My si Section
Tertiary Author
Savage, V.. 2014 ASer| |Tertiary Title
Edition
Date
[ List each author separately
0 In other fields, list each entry that is separated by slash, c3
return or line feed, (Keywords entries are always listed sep
L line feed. (Ke ds entri I listed
Cancel
4 Term(s) Selected
Help




Subject Bibliography - My EndNote Library0413.enl X
Output Style:| APA Tth ~ Terms...
REFERENCE LIST: ~
Book (2)

Kalaskar, D., & Kalaskar, D. M. (2017). 32 printing in medicine (1st
Publishing.
Kocovic, P. (2017). 3D printing and fts impact on the production of fi
emerging research and opportunities. Engineering Science |

Conference Proceedings 4

Berman, A., Thakare, K., Howell, J., Quek, F., 8 Kim, J. (2021). How
to support anyone to 3D print anywhere. 26th International
Interfaces,

Beyer, D., Gurevich, 5., Mueller, 5., Chen, H.-T., & Baudisch, P. (20
fabrication of 3D objects by substituting 3D print with laser-
33rd Annual ACM Conference on Human Factors in Computi

Savage, V., Schmidt, R., Grossman, T., Fitzmaurice, G., & Hartmani

Adding interactivity to 3D prints using internal pipes. UIST 2

Annual ACM Symposium on User Interface Software and Te

lin F Ra 7 Ren K Zhnn © & ¥o W (201481 Mw ami

Snnn 7

Help Print Preview...

Subject Bibliography Setup
References Terms Page Layout Bibliography Layout
Output Style: | APA Tth w

Reference List Title:

REFEREMNCE LIST:

TREEEHE
ERGHE - 0

Bibliography Sort Order

(O Order of Appearance Y A=
O Author + Title Other Tﬁ %E\ DR/E
® Authar + Year + Title

(O) First Author + Year + Other Authors
(O First Author + # of Authors + Year
() Other...

[ISort Edited Works After Original Works By Same Author.

EndMote Defaults

Sort Options >

Use the following controls to choose up to 5 fields as criteria
for custom sorting.

Sort First by this:

fear i :_

Then by this:

Authar ~ =

Then by this:

Journal{Secondary Title il =1

Then by this:

Mone o :_

Then by this:

Mone E :_

Sort Language:

System Default bl
Cancel




Subject Bibliography - My EndMote Librany0413.enl

Output Style:| APA 7th ~ Terms...

REFERENCE LIST:

Book (2)

Kalaskar, D., & Kalaskar, D. M. (2017). 30 printing in medicine (1st edition ed.). Woodhead
Publishing.

Kocovic, P. (2017). 30 printing and its impact on the production of fully functional components :
emerging research and opportunities. Engineering Science Reference.

Conference Proceedings ()

Savage, V., Schmidt, R., Grossman, T., Fitzmaurice, G., & Hartmann, B. (2014). A Series of tubes:
Adding interactivity to 30 prints using internal pipes. UIST 2014 - Proceedings of the 27th
Annual ACM Symposium on User Interface Software and Technology,

Beyer, D., Gurevich, 5., Mueller, 5., Chen, H.-T., & Baudisch, P. (2015). Platener: Low-fidelity
fabrication of 3D objects by substituting 3D print with laser-cut plates. Proceedings of the
33rd Annual ACM Conference on Human Factors in Computing Systems,

Song, C., Lin, F., Ba, Z., Ren, K., Zhou, C., & Xu, W. (2016). My smartphone knows what you print:
Exploring smartphone-based side-channel attacks against 30 printers. Proceedings of the
ACM Conference on Computer and Communications Security,

Help Print Preview. .. Print... Save...

Rerman A Thakare K Howell 1 Onek F o8 Kim 1 20211 HowDTY- towards meta-desian tonls

Close

Book (2)

Kalaskar, D., & Kalaskar, D. M. (2017). 30 printing /in medigne (1st edition ed.). Woodhead
Fublishing.

Kocovic, P. (2017). 30 panting and its impact on the production of flly functional components :
emerging research and apportunities. Engineering Science Reference.

Conference Proceedings Gl

Berman, A., Thakare, K., Howell, 1., Quek, F., & Kim, J. (2021). HowDIY: towards meta-design tools
to support anyone to 3D print anywhere, 26th International Conference on Intelligent User
Interfaces,

Bever, D., Gurevich, 5., Mueller, 5., Chen, H.-T., & Baudisch, P, {2015). Platener: Low-fidelity
fabrication of 3D objects by substituting 3D print with laser-cut plates. Proceedings of the
33rd Annual ACM Conference on Human Factors in Computing Systems,

Sawvage, V., Schmidt, R., Grossman, T., Fitzmaurice, G., & Hartmann, B. (2014). A Series of tubes:
Adding interactivity to 3D prints using internal pipes. UIST 2014 - Proceedings of the 27th
Annual ACM Sympasium on User Interface Software and Technology,

Seng, C., Lin, F., Ba, Z., Ren, K., Zhou, C., & Xu, W. (2016). My smartphone knows what you print:
Exploring smartphone-based side-channel attacks against 30 printers. Proceedings of the
ACM Conference on Computer and Com munications Security,

Journal Article (74)

Bai, 1., Wang, Y., Zhang, P., Liu, M., Wang, P., Wang, 1., & Liang, Y. (2018). Efficacy and safety of
3D print-assisted surgery for the treatment of pilon fractures: @ meta-analysis of randomized
controlled trials. Journa/ of Orthopsedic Surgery and Researct, 13(1), 1-9.

Chen, D., Levin, D. L. W., Didyk, P,, Sitthi-Amorn, P., & Matusik, W, (2013), Spec2Fab: A
reducer -tuner model for translating specifications to 3D prints [Artide]. ACM Transacbions on
Graphics, 3:(4), Artide 135, htips:/fdoi.org/10,1145/2461912, 246 1994

Coakley, M. F., Hurt, D. E., Weber, N, Mtingwa, M., Fincher, E. C., Alekseyev, V., Chen, D. T., Yun,
A, Gizaw, M., Swan, 1, Yoo, T. 5., & Huyen, Y. (2014), The MIH 3D print exchange: A public
resource for bioscientific and biomedical 3D prints [Article]. 32 frinting and Additve
Manufaciuring, 1(3), 137-140. https:/fdoi.orgf10.1089/3dp.2014. 1503

Dostalova, T., Kasparova, M., Kriz, P., Halamova, S., Jelinek, M., Bradna, P., & Mendricky, 1. (2018).
Intraoral scanner and stereographic 30 print in dentistry-quality and accuracy of model-new
laser application in clinical practice. {aser physics, 25(12), 125602, https:/fdoi.org/10.1088
1555-66 11/aae067

Femmer, T., Kuehne, A, 1. C,, Torres-Rendan, 1., Walther, A., & Wessling, M. {2015). Print your
membrane: Rapid prototyping of complex 3D-PDM3 membranes via & sacrifical resist
[article]. Journal of Membrane Scence, 478, 12-18. https: f/fdoi.org /10,1016
j.memsci.2014.12.040

Gilbert, F., @Connell, C. D., Madenovska, T., & Dodds, 5. (2018). Print Me an Organ? Ethical and
Regulatory Issues Emerging from 3D Bioprinting in Medidne [Article]. Sgence and
Engineering Ethics, 24(1), 73-91, https:/fdoi.orgf10,1007/511948-017-9874-6

Guo, T., Holzberg, T. R., Lim, C. G., Gao, F., Gargava, A., Trachtenberg, 1. E., Mikos, A. G., &Fisher,
J. P, (2017). 3D printing PLGA: A guantitative examination of the effects of polymer
composition and printing parameters on printresolution [Article]. SioSdricatior, 5(2), Article
024101, htips://doi.org/10. 1088/1758-5090/3a6 370

Huang, W., & Zhang, X. (2014). 3D printing: Print the future of ophthalmology [Artide]. Invesfgative
Ophthalmology and Visual Sgence, 55(8), 5380-5381. https://doi.org /10,1167 fiovs, 14-15231

Huber, C., Abert, C., Bruckner, F., Groenefeld, M., Muthsam, Q., Schuschnigg, 5., Sirak, K.,
Thanhoffer, R., Telban, 1., & Vogler, C. (2016), 3D print of polymer bonded rare-earth
magnets, and 3D magnetic field scanning with an end-user 3D printer, Aoglied Physics
Letters, 105(16), 162401



# B BB BE B EdNoe Q%

Calori(F%) <12+ A & Aa- A ag[A] 2

vegng B I U anx|A-Y-A-NQ Bs==8E &-5. | oAx | .EER &
5] r] il 5 oz B

=5 . sunr

Bl x| |=

2TER EEN . EndMote B\'bh'ogra‘phy

BIREE) < AX

EndNote Bibliography

P . L= ZEER7ET(S): | 1 EndNote Bibliograph:
EndNote Bibliography Title EﬁEﬂNDte B\bho_qﬂph-;wr Sraphy

ERARE

A
25 Lapheen napbccd AQB AQBI AaBbC AsBoccd AosbCeD AsBbeD AcBhccD AaBbCed AdBbCcD AaBAC:D AsBBCCD AABSCED AaBbOcD

g3z =] HEE  EAEE BEnE EEEE O uEEE S BESC EREEE sHEE 22

=3 [

journal
Guo, T, Holzberg, T. R., Lim, C. G., Gao, F., Gargava, A., Trachtenberg, J. E., Mikos, A.

G., & Fisher, J. P. (2017). 3D printing PLGA: A quantitative examination of the

effects of polymer composition and printing parameters on print resolution

[Article]. Biofabrication, 9(2), Article 024101. https://doi.org/10.1088/1758-

5090/aa6370 «

EndNote Category Heading £ M- HABE @Fxav] 12 v| B I U ‘ =z o=z =
mi §§§§|—zz|$§:§§§
BEE
(Guo et al,, 2017; BRIEE & ERSSHE, 2015)
fEEE o
EE1 0@
EE2 ] ‘
£ 0 ?%éﬁ%ahbm FERARTUCERE 82 884
ETEE
FREENES Osess=xEg Osasgsy
. ® REgZHD) O RERLETRUNHTE
ul %) Y | =R

#EAQ ~

Julian Louis, M., Tobias, H., Florian Markus, T., & Philipp, B. (2022). Clinical

acceptance of advanced visualization methods: a comparison study of 3D-




EEHENE

Q : &ZYIZEEndNotels - EZE Typical
B - BERIB S B8 EEZ /Y
Custom#Z (g ?




3Custom

w

ZHIEI0 : Typicaltl &

BT
o == FERENEATINAEE
[ sm= o] mE=ReE P EndMote 20.2.1 Setup — e
B R::;/I;;soﬂsto ! 500%$E_>7000%$§
e [rmem EndNote 20 Application Maintenance
iz mERmRES FEREAAY |
o e BEAPE Qriin . o :
2 = Change which application features are |nﬁ EndNote 20.2.1 Setup —
; ERESRTRIE I J
@ LIERESEEsuEL Select Features dialog, which lets you co
EEBEES - 5 features.
o mRER WRSEARR O Reparr EndNote 20
L Hei?:tall mizzing or corrupt files, registiy k
P TN s p e 4

Preferences stored in the registry may be
B#E 10 EEES values.

@ - 2-
20.2.1.1574

() Remove
Uringtall EndMote 20027 from this compl

[T

Additional Stylez
Spelling Dictionaries

< Back | MHest > -

l ( )

< Back Cancel

Disk Cost Reset




-+

)

EndNote :
of RFRE =

h 3 \El

. RE=

e

t&TVRY TS

44

E3MEndNote?E BUE T i A FAwWord

B B#.., 2014 #13 Summary Edit PDF X

B FEEFE3dNNERLmR ..

+ Attach file

FREHHIIINER Lz mSERE--
UFERH

B8, W5 and RS

B EEBmER 2014 Vol. 2014[E103)5%

VS

[apa7th v | [ insert | | Copy | v

[l sh, Bs5)%, & BRI, (2014). E4EHERY213d
SHER M mrmISEZE--LIFERH.
B (EEEZiEH 2014[F103] &
153-162.

Choose A Style hed
MName Category A
APA 5th (sections) Psychology
APA Sth-Annotated Psychology
APA Sth-full name Psychology
APA 6th Psychology, Multi-disdplinary
APA 6th - Sentence Case Psychology
APA 6th (sections) Psychology
APA 6th CV Psychology
APA 6th Nederlandse editie Psychology
APA 6th-Annotated Psychology
APA &th-full name Paychology
APA Tth Psychology, Multi-disdplinary
APA Tth Icelandic Education
ARA T rhTHE HERE e AE v

|Quick Search ~ | Find by *
4 |ess Info: Style Info/Preview Cancel

File Name: APA 7th.ens

Created: 2022848130, T 01:16:55

Modified: 202187818, FF 01:08:04
Based On: Publication Manual of the American Psychological Assodiation (APA)
Category: Psychology, Multi-disciplinary

Comments: |This output style is based on the Publication  ~
Manual of the American Psycholocial v

Word :

A-ZHEF

EndMote 20 Styles

MName

Category

3 Biotech Biotechnology

AAA Style Guide
AABC

AAG Style Guide
AAPG Bulletin

AAPS

AAPS PharmSdTech
Abacus

ABMT (Author-Date)
ABMT (Author-Dat. ..
ABMNT (Citation Or...
Abs ICA

Absorption Sd Tech
Acad Emergency ...
Academic Medicine
Academic Pediatrics
Academic Psychiatry
Academic Radiology
Academy Manage...
Academy Manage. ..
Academy Mgmt Le. ..
Accident Analysis ...
Account Audit Acc. ..
Account Org Soc
Accounting and Fi...

Arrnnntinn Bicine

Anthropology
Science
Geography
Geology
Medicine
Medicine
Women's Studies
Science
Science
Science
Geosdence
Chemistry
Emergency Medicine
Medicine
Pediatrics
Medicine
Radiology
Business
Business
Business
Science
Accounting
Accounting
Accounting

Arrnnintina

Cancel

Help




Q : YA EEndNoteZ FHAPAZE7HR
th3ZhROutput Style ?




Go g|e apa 7th SIAR x & Q
Oz EFE QnE BDEE BDER (8L =
#75 6,680,000 EES (ESEMH 037
http.fflibra_w.mmh.urg tw > CitationManager «
SEEZEEndNote = B EIEEE
2021=1086E
EndNote 20 5§ . £f
oy Bt it
A e MacKay Memorial Hospital g
Hig A thgs LB RARY %ﬁﬁ
endnote apg
apaiEIEE
apa¥tiE
SEVEER /odESEREgE
» Endnote 20 2¥hREIINEE TR — APA Tth_chi (1).2i
= _chi (1).zip
= EFTAPA 7th|l £ APA 7th P 30RR_# _ - —
EEFIEndNoteSTatESPTeTeTETCES - || BERERAIR
ag
B2EE
APAT.. v |0 S 22 APA Tth_chi (1).zip
2% : &l EEA
* APA 6" 3ThR :
T APA Tth iiF_EIBEE(FIEF..  EndNote Style 3KE
E_[HQGOOQE‘ EE"APA XXC” > % APA Tth PIif EEES(UFIR . EndNote Shle 48

NEAPA 6 TW_022.ens

ER=E

BEERE AN

T | T

wa | ra
[ R E)




w15 Output Style BHIFEF AT

BEEHEMEL

« 2T >File>Save as...> 4REBIEZ

ESIESEE RPN

« K>3 >EndNote>Styles ( 577 )
« At >(C:)>Program Files>EndNote 20 >Styles ( 785&



2R AmE - ERRIRREAA—%

D2 EREMEINEEEM - FEET

(i

File Edit. F"h pups Library Tools Window * KEE/H\HE%E
o DIERETIAE  PXBAE

et Technical Support

EndNote Output Styl ™
. . 3 . Check for Updates... EndNOte
dianelin1222@gmail.com

EndMote Community

All Refere

Search Knowledge B GetsStarted
EndNote Training Po Style or Journal Name Citation Style Discipline
Al | R f EndNote online APA Tth - American Psychological Association Tth Edition  Author-Year-Cited Psychology, Multi- 2022-04-29 Download
erer

Pages disciplinary
Download EndNOte New Zealand Veterinary Journal Author-Year Medicine 2022-04-19 Download
108 Refere
o Rece nt|y Added Activate EndNote International Journal for Parasitology Author-ear Parasitology 2022-04-19 Download
_ . Comma Delimited (CSV] None Generic 2022-03-29 Download
ELLIED ) About EndNote 20
T LGBT Health Medicine 2022-03-15 Download
MIS Quarterly Author-ear-Cited Library Science 2022-03-04 Download
Pages
Digestive Endoscopy Superscripted Gastroenterology 2022-03-03 Download
s 51 . a Number
- [CIEERIVERE
EE gI\V[oJER . Acta Pharmaceutica Sinica B Superscripted Science 2022-02-17 Download
MNumber

EE F-%'ﬁ_ ’_E_‘ %lﬂ > %Z:Etgﬂ *Z > End Note > 7|ta Fég @%ﬁ > Textproduktion und Medium Linguistik 2022-02-15 Download
EndNote Output Styles Request Form & #75>K [0l é&

English




EZHIBHEE

Q : KREEBABEA—HREENK
By - MREHREBBLEFNATE - &
FBE/BEEEIHIE ?

A BEEBNETHRE  BARES
HoRIET -




}

X

APAHRTIREEE =R - (BEEIRBH

-y

Nt

—&

Install EndNote Click Browser Extension

#ZHJournal Names#E18 - &

I Output Styles 2 I New Style... E)'L Z'_‘E >Be IE
Import Filters ' Edit "APA Tth"
Connection Files »||  Edit"APA6th® e G il Oieo G —
i i i Open Style Manager... Plain Font Plain Size ‘
Cite While You Write [CWYW] 4 ----»:buutthfssw\e A soumal Name Format
unctuation
Format Paper 4 Annotated Anomymous Works ® Use fulljournal name
Subject Bibliography... APA 6th [ T O Abbreviation 1
o APA th ’;i:“;“:‘m“ ) Abbreviation 2
Show Connection Status Citations () Abbreviation 3
APATth IR BERE(FUWIIRES) | rempistes O an'treptace
Online Search.. Ambiguous Citations
Autho r Year T Author-Date - Author Lists [[] abbreviate journal articles only
Chicago 17th Footnote ’:J“t“z'Nama .
umbering
MHRA (Author-Date) - Sort Order
=81, 2020 e ') Sblography
Templates
. ) Numbered E:::ustubsmms
=&, 2019 & Show All Fields - Sor Order
.. Categories
e Turabian 9th Footnote Author Lists
=
= i1 - Authar Name
=25A, 2021 E Vancouver - editorLists
Editor Name
. Title Capitalization
- Footnotes
Templates
A AT B E AR s
' = -~ [=] . Repeated Citations
Author Lists v




\

— & RRIEEEIRISEndNote 5 E

Libra
Sync
Advanced Search Ctrl+Alt+F vy}
ARSHTNREEGS
Find Duplicates
Find Broken Attachment Links
Remove Broken Attachment Links...

Term Lists

Terms  Lists

62 Journals in the Journals List:

Open Term Lists 4 Authors Term List — — —
- Full Journal Abbreviation 1 Abbreviation 2 Abbreviation 3 2 o
Define Term Lists... Cir+4 Journals Term List 3D Printing and Additive Ma... sw e
Link Term Lists... Ctrl+3 Keywords Term List 3D printing in medicine Edit Term...
— ACM Transactions on Graphics
Spell Check Ctrl+Y - T|t|e AE:’I Transacti?ns on Graphi... Delete Term
Additive Manufacturing

Find and Replace"' Ctrl+R Anatomical Sciences Educati... Insert Term
Change/Move/Copy Fields... - s Applied optics (2004

ge/Move/Copy 18 3D print additive te€ | applied physics Letters

Recover |_||:Jr’ar3.I Biofabrication

Computer Graphics Farum

14 ﬂzﬂﬁgﬁﬁﬁ:‘;ngED‘ |EEE transactions on evolutio...

Industria textils (Bucharest, R...

Library Summary

International Journal of Phar...

Investigative Ophthalmology...

Journal of Failure Analysis an...

Journal of Membrane Science

Journal of Orthopaedic Surg... v
< >

Hint: Hold the Ctrl key to select multiple terms

Close




erm Lists

. oo A5 Z = . . j:tb -_ Z [y |
ferm : BE4RE Lists : #ERARE
Term Lists X Term Lists
Terms  Lists Terms  Lists
62 Journals in the Journals List: My EndNote Librany0413.er Create List...
Full Journal Abbreviation 1 Abbreviation 2 Abbreviation 3 @ h
New Term Authors Rename List
3D Printing and Additive Ma
3D printing in medicine Edit Term Keywords Delete List.
ACM Transactions on Graphics
ACM Transactions on Graphi Delete Term
Additive Manufacturing
Anatomical Sciences Educati. (=il TEm
Applied optics (2004) Delimiters Update List..
Applied Physics Letters . ; - Y\ /
Import List...
Biofabrication P
Computer Graphics Forum Custom Delimiter B
|EEE transactions on evelutio... Carriage return is always used as a term delimiter.
Industria textils (Bucharest, R EnE il
International Journal of Phar
Investigative Ophthalmelogy...

Journal of Failure Analysis an..

Journal of Membrane Science

Jourmal of Orthopaedic Surg = 1 :éf ;'I{SI— }E K - EE ﬁ {Eﬁ :,E\:H :HJ

<

I g
Hint: Hold the Ctrl key to select multiple terms E -Fq- & IZ“1E 70y

Close Close




Term Lists

Terms  Lists

62 Journals in the Journals List:

Full Journal Abbreviation 1
3D Printing and Additive Ma..

3D printing in medicine

ACM Transactians an Graphics

ACM Transactions on Graphi

Additive Manufacturing

Anatomical Sciences Educati...

Applied optics (2004)

Applied Physics Letters

Biofabrication

Computer Graphics For

|EEE transactions on evc
e 1 Erm
International Journal of

Investigative Ophthalme,

Joumal of Failure Analysis an

Journal of Membrane Science

Journal of Orthopaedic Surg...

<

' AEndNoteFazz B HIiB &

BB RAMTerm ListsMIk:

Hint: Hold the Ctrl key to select multiple terms

4B KB

X
EIEAR T BRI tE > FRL
~ =
FE AT == Jixtis > FH e
Term Lists x
Terms Lists o sze
© EE
My EndNote Libi 13.er v Create L
y EndNote Library0d13.e¢ reate List 4 s ZH > RHES(C) > Program Files (x86) > EndNo.o 20 » Terms Lists
Authors Rename List..
BEwE v HEENE
Keywords Delete List.. = BE P - %I
@ OneDrive - Person [5] anthropology.tt
= 5] Archasology.tt
. B =g [E Astronomy and Astrophysics.txt
Delimiters Update List ¥ 3D 5 BioScience.txt
- A\ § AppleiPhone [E chemical.ext
Custom Delimiter: ¥ 7= 5 Economics.bxt
Export List.. - iti
Carriage return is ahways used as a term delimiter. R e 5] Humanities ot
i J’ == S Eura; Medical Terms.txt
. W]
=
. =i
Lists>Impor = Ehn.
p =l &k [E Philosophy
E=x [E] Physics.xt
i, 2EEE ©) 5] Religion bxt
o TEEE D) |2 Zoological Records txt
b EE v
s=EN || |

Text file (*.txt)

EE(0)




Style:s E M A& Al

= =/1 o~
=R BT
EREIEEEBIEE R - WMAIEEE - BHRERAEAXFHAS
Citation
Journal Mame Format ‘
@ Use full journal name {Author, I"fea rl , Iplpp. IE iteleagesI}

() Abbreviation 1

O bbreviation 2 meit | BRER| MXT
|

|

Abbreviation 3 | | s I 1
O Irewa on ; -- ENEE -- :
() Don't replace I I
| |

R RBWA -------



kT K E1TStyle iR

Tools Window Help

Plain Font Plain Size
About this Style A || tn-Text citations
Punctuation In-Text Gtation Template
Anonymous Works —
Page Numbers
Joumal Names
Sections Citation (Author,-|Year|,®p."pp.°Cited-Pages|) DA
Citations APA 6th
Eisnplzie Citation - Author (Year) Author®(|Year|,°p.”pp.°Cited-Pages|) File Edit Tools Window Help
- Ambiguous Citations
o e 1
Author Lists - Plain Font | plainsize[v|| B I U P ‘ At A z Aﬁﬂ‘
Author Name
Numbering { ;- About this Style A || nText Gitations
Sart Qrder Punctuation In-Text Citation Template
Bibliography Anonymous Works Insert Field
Templates 4 Page Numbers
Field Substitutions ] - Joumal Names
Layout Sections Citation (Author,-|Year|,®p.*pp.°Cited-Pages|)
- Sort Order Citations
Categories 1 - Templates Citation - Author (Year) Author®(|Year|,°p.*pp.°Cited-Pages|)
-~ Author Lists N N . N Ambiguous Citations
Author Name. O Sk =1 =a R 51 A Author Lists
Eaor e Xrm 2 A kB O TV A ¢ aorname e T %
Editor Name Numbering :
Title Capitalization Sort Order
- Style name: save
Footnotes eibhogranhy [sme ]
Templates Templates Cancel
Field Substitutions Field Substitutions
Repeated Citations Lavout
- Author Lists 1 V
aathor Mo F| - Sort Order
- Editor Lists 1 Categaries
Editor Name - Author Lists
Title Capitalization Multple ctation separator: ; Author Nama
Figures & Tables Editor Lists
Figures e ocna] 1 . Editor Name
L v [Juse 2-igit years (99) Title Capitalization
< 4 Footnotes
Templates A —— % hY 74— Q S =
P submitions =9 TE Save as #E1T JIFE 17
75
Repeated Citations HR TG =] I A
H . Author Lists
. T|p5 : - Author Name
Editor Lists
Editor Name
. FER Afo O 2N FF) | S Title Capitalization Multiple citation separator: [;
. SRR IR ELRE p
=~ 1 ~Figures Year Format
P v [ use 2-digit years (29)
< >

« RFF - BITIRRE - ABEASTVETT R




E (FAR A

i

FRAL : SR (A B
BRI R AT AR RO RIS - IS IRI AR -

Volume:-(Issue)

EINERZE Issuet@I - IssueBERNRER - IHilAZE 2 HIR -

MRRAI2 . AU AR T

mER A BRI - ARERAZER - AR R -

Author.Title

A FIRZEAuthorfdfil - AuthoraZE B - OBt A= HIR -

ERKR : HEER



E (A

 FRAI3 : WAIBE—EZ=EBRMEZEL - F_EE ErvizEz=1EAIIEI

WU RFTIENE —EZ BRI ZEA - ZBUFERSREZERZEEFE ; 8
UREEEBERA—EZR S _ENENEEERR/BUFE - EwmzRHUZE8
NE @ BENZERHITLIR -

Author. Title (B ZE—1%)

Z Author BREARHK - XM REZERE AT HIR - Title A1 A HIRZEE -
Author.--Title (5 [EZEmM1E)

2 Author REARK - A _EZE\IFE - Title B #F HIR—EZEE -

ERKR : HEER



B A

- RA4  BUXFHGLIER
BRI BRI FEE RN - TREREEEL DELRERESS -

Edition -ed. ( Edition #8173 ed. FEZE—1%) - & ed. A& Edition - FH#E
@ Edition AEAZS - ed. HEHIR -

ERKR : HEER



= A\
S IT4A

1. End of Paragraph ()

=B AFTERTT - FEE End of Paragraph (1) 2RI817 -

2. Tab (%)

MREEHBNFZERENFIEERAR - off£H Tab (+) /&5 - RI—EXRERE -
3. Link Adjacent Text ( o0& ° )

N BB E—iE  ARBEEXFMPE - Al - SHEEBEVAEE—TE - A0
26 - B8 T O UA Link Adjacent Text &55% (¢ 3% °)2RELE -

ERKR : HEER



= A\
S IT4A

4. Singular/Plural (")

KIBEERMOEEE - WEEZEONE - AU EENE  SIHEEFER"p. B " -
ZEAIER " pp. B " 2R - ERm O RIEASingular / Plural 538 (~) 2REE R -

5. Forced Separation (|)
81 Link Adjacent Text BliFtEf - S22 RAREREN - FEHEXEMRNE G

6. Field Names in Bibliographies ( ")

SEVBTERIRNFS - BIFEEuaEEEE - AINERTNERREFN L
“Volume: " 3§ “ Issue: ” - SRTEAREEZE H NN L Editor ” - UIERFELI( ) KRB FER

7 /__lz o —f— ~ = <
EBEE ERIE - EBEE



— X EARIGEIRPEIET

EWordfEFHEndNote 2 815 - (ZRcEE
—71&Output Style23R5|I3IREZEEHM
B - BUPXEFRN - APRYX

BB BREAR  SE®BESR—FI8
BB -
XPAAPA 18 T i e 453K




&1 BIRs

\\),t

2B AL I

TR A

RAmIER X P ERD / FISCAPATSTU

BREE - EEXE—MESHRD / BUETUM XX

RrAmEE RSB RERS / AXAPARST

BREY - EESZ—MWSERIP / AXETU XX

VZSHERXARE  KRROZHEHERM L

(((((



FiE2 . ZINEFEECER

PRIRAREE I - ZRR— 1 Z=HEWord

J

ZEHWord FAZRB B M LR AR EE S IMY 3 — /AR

J

\

i’ 22 AWord Ry th /52 AR B AL E 2B A ERSH

B ERSENE IR EERRE RS

ZHRT  =EBRESZEEHML (FDH2-4)

€C€CE€



753%3 . FIFHEndNote5e = f# R

FABARE

H1Z b X Reference Type : Edit>Preferences>Reference Type>unused

5 AR AH bR IHBES EndNote LibraryZx ZE B E DX X BliReference Type

Tools>Output Styles>Edit APA 6">Bibliography>Templates

Reference Types>2)E /I Fr#TZAI>File>Save as>an & #HOutput Style & &

EndNoteZ H EZE¥an 2 Output Style - BI5ERL | ( Hr%ACitationVEF BB HRLHTY )




C e e =

‘.‘" , gt o kot ) &
) s sl S
[hanks!

E’% 3_|9X@.ma~i‘f:‘fku.edu.'_tw
@ : __2-5215656_#?2365"_

ie f_._.‘; '.q BiRsreEENE

Ca



